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Seminar Type:  Microsoft Products, Sales & Marketing 

 
Seminar Level:   
Part 1: Basic/ Introductory:  An introductory level course is basic in nature and addresses 
fundamental concepts. We expect attendees to have a basic level of insurance knowledge, 
have been oriented to an agency‘s processes. For functional courses, it is not necessary for the 
attendee or participant to have previous knowledge of the agency management system or 
software program.  

 
Part 2: Intermediate Level: An Intermediate level class takes the concepts originated from a 
basic level course, and adds more layers or parallel concepts. For functional courses, these 
classes will require the participant or attendee to have some basis to work from as they are 
learning new facets of the agency management system or software program.  
 

Class Description:  This 2-part session will go all the way from a review of Word features 

and functionality through creating sophisticated form letters and proposals. Part 1 will take you 
through the basics of creating form letters and proposal templates that are integrated with TAM 
data. You will learn how to access the data in TAM, the use of simple ASK variables and IF 
statements, and much more. Part 1 is geared toward the novice user.  
 
Part 2 expands on the basic information provided in Part 1 and adds pulling schedules of 
exposures from applications in TAM, and how to use Styles to make the appearance of merged 
proposals uniform & unique to your agency. You‘ll learn how to combine ASK and IF Statements 
and nested IF Statements, and how to insert images based on TAM data and use Field 
Formatting to alter the look of merged data. Part 2 is for the intermediate to advanced user. 

 
Learning Outcomes:   

 Create formletters and design proposals incorporating TAM data 

 Understand basic Word formatting as used in TAM setups 

 Expand basic TAM/Word interface skills, set unique consistent styles for your agency 
documents, design professional proposals beyond basic templates 

 
Assumptions:  This seminar is based on the following 

TAM Version 11.X 
Microsoft ® Word Version 2007 
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Part 1 – The Basics 

 
The TAM/Word Interface is one of the most powerful tools in the TAM ―arsenal‖.  This 
interface allows you to use data entered in TAM at client/prospect, policy detail and 
application levels to populate formletters and proposal templates in Word.  The 
integration of these two products gives your agency the ability to generate letters and 
proposals that have a uniform look and feel and allows those documents to be 
―branded‖ with your agency logo and colors. 

What Custom Formatting Can Look Like 

Below is a comparison of how custom formatting can change the look of your proposals.  
The example shows the business auto vehicle schedule section from the default 
proposal template in TAM, followed by an example of how the same schedule can look 
after the template has been customized. 
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The important thing to note here is that no editing was needed after merging this 
―customized‖ proposal page. The standard proposal (above) needs editing before it can 
be delivered to the client; the customized page requires little to no editing before it is 
ready to be delivered.  
 
Almost every feature of Word may be utilized in proposals and form letters.  However, 
there are some features that cannot be used.  The proposals setup by Applied Systems 
are a series of macros that allow an interface between TAM and Microsoft Word, 
commonly known as the TAM/Word Interface.  Accordingly, items that ―Protect‖ 
documents such as the Form Field functions of text boxes, drop down lists and check 
boxes will not work within the Interface. If you would like to take advantage of these 
features, then you must remember to utilize them outside of the Interface. 
 

What’s the difference between a formletter and a proposal document? 

As mentioned earlier, TAM integrates with Word via document macros within template 
files. Both formletters and proposal templates can be associated directly with a specific 
policy application or custom dec page allowing the data (limits, exposures, etc.) from the 
application to be integrated.  The main difference between formletters and proposal 
templates, is that a formletter, once created, stands on its own and is accessible by the 
end user from Attach, Add, Letters, Formletters.   Individual proposal templates are not 
available for merging until they are made part of a Proposal Setup. In order for 
information from applications to merge into a proposal, each policy/application type 
requires its own template.  When all of the templates are complete, then they must be 
added to a proposal setup in the order you would like them merged in the end product.  
There is no required number of templates in any proposal setup.  They can be as simple 
or complex as you need. 
 
Documents – both formletters and proposals – can be set up to pull info from more than 
one application type, subject to limitations. 
 
And do not feel limited by the names ―formletters‖ and ―proposals‖. Both can be used for 
much more varied purposes than the names imply. For instance you can set up a 
custom form, such as a city‘s performance bond, or a company-specific application, in a 
formletter. And you can use proposals to create summaries of insurance, renewal 
review checklists, for example. Formletters are created separately for clients and 
prospects, while proposals are accessible from both sides – so you could use proposals 
to create a letter used in both clients and prospects, and only need to create – and 
update – it once. 
 
The next few pages take us through the process of creating formletters and proposal 
documents. But it‘s important to understand that once you‘ve gone through the Applied 
set up screens, and have the document open in Word, the techniques we use are 
identical in formletters and proposals. So we will switch back and forth between the two 
as we demonstrate the various techniques. 
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Document Setup 

The heart of working with documents and TAM starts in the Customer Formletters 
dialogue box shown below.  On the left side of this screen under Document Type, you 
can choose to work with a variety of types of entity formletters: Customer, Prospect, 
Producer, Company, Broker, Lienholder, Finance Company, Employee, and Vendor.  
The next two options, Proposals and Dunning Letters, are similar to formletters but 
serve different purposes. 
 

 
 
Under Options, there are two choices, Documents and Folders, which allow you to jump 
between seeing the list of documents for the entity type you have selected under 
Document Type, or seeing the folders for the type you have selected under Document 
Type. This is true for all Document Types except Proposals.  When you have selected 
Proposals, your two Options will be Documents and Setups.  Setups will be discussed 
in detail with Proposals. 
 
The middle of this screen lists the items determined by the selections made on the left.  
If you have selected Documents under Options on the left side of the screen, you are 
given the preview button on the right.  Preview opens a sample of the document in 
Microsoft Word Viewer.  Preview is not shown if you have chosen Folders under 
Options on the left. 
 
At the top of the Customer Formletter screen are three radio button options: All 
Formletters, Word Formletters and Editor Formletters.  Word Formletters are the only 
formletters supported in the most recent versions of TAM, so make sure that radio 
button is selected. 
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Organizing Your Formletters 

Formletter Folders provide an efficient way in which you can organize your documents 
and it is a recommended step in your setup process. 
 

 
 
When any Document Type other than Proposal is selected, you will have two Options: 
Documents and Folders in the lower left hand corner of the Customer Formletter box.  
The Folders button displays the folders that have been created to organize the 
formletters.  In the example above, there are four formletter folders created for 
Customer letters.  Folders are a way to present a smaller list of options to users when 
they are adding a formletter from the client level. You can have many more folders than 
shown here, and a single formletter can be assigned to more than one folder.  For 
example, if you send the same loss follow-up letter to both your personal and 
commercial clients, that letter can be in both folders. 
 
At the user level, once they have gone into Attachments, Add, Letter, Formletter and 
selected a folder, that becomes their default folder. So a PL CSR for instance can set 
her workstation up so he/she only ever has the list of PL formletters – presumably a 
shorter list than the list of all letters in the agency. (The other folders are still available, 
of course.) 
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Adding/Editing a Formletter 

When you want to add a new formletter, select the appropriate Document Type radio 
button on the left side of the Customer Formletter screen, then select New from the 
bottom.  You will be asked ―Do you want to add a new <entity type> formletter?‖; click 
YES to continue. 
 

At the Formletter Setup option dialogue box, 
the first box asks you to Name the 
formletter. This name field is limited to 8 
characters.    You can use this file name to 
easily group your formletter templates by 
department (for example, starting all letters 
specific to the Personal Lines department 
with a ―P‖ will group them in the Document 
Setup area.  In our example, let‘s use 
ENDTINSD.  This applies to proposal 
documents as well. 
 
Next you are asked to provide a Description 
of this letter.  This is a longer field allowing 
for you to be more descriptive. 
 
Note:  While in Document Setup, documents 

are filed alphabetically based on the code. When you are adding a letter to a client, the 
formletters are alphabetized by description. So we suggest that at least the first 
characters of the file name and the description be the same – this makes it easier to find 
the documents in the list later on. 
 
The next section allows you to choose what Association you want to make – and by 
doing so, determine what information you can pull into your document.  You can select 
an Associated Form such as an ACORD application or custom dec.  You also have the 
option to merge information from the Claim, Contact, or Commercial Info screen. 
 
By selecting Contact, this allows you to pull specific information from the contact area of 
TAM. 
 
If you choose to associate with a Claim, you will then activate the option to also 
associate with a particular Loss Notice – Auto, Liability, Property or Work Comp.  If you 
want to create a letter that only pulls information from a claim detail screen, simply 
select claim.   
 
By selecting Commercial Info Screen, this allows you to pull specific information stored 
under the ‗Info‘ button. 
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The next area of selections relate to the Activity Defaults.  You can choose to associate 
this letter with a particular Marketing Plan (you can enter in the code or double click for 
a list of all marketing plans entered in your system).  It is not required to select a 
marketing plan.  You are required to select an Activity Category.  Again, you can enter 
the code if you know it, or double click for a list of activities entered in your system. One 
option is that formletters have their own unique activity category assigned.  This allows 
the generation and saving of the formletter to be an auditable step in your agency‘s 
workflows. 
 
Print Batch is the next selection – double click for a list of print batches installed on your 
system to select which type of paper this document should be printed on if it is printed 
through Closeday instead of immediately. 
 
Finally, you must select an Attachment Category, double clicking for a list of options 
from your system.  

Adding/Editing a Proposal Document 

To create a Proposal Document, in the 
Customer Formletters screen, click on the 
Proposal radio button and then click New.  
You will be asked if you want to ―create a 
new proposal document‖; click Yes. 
 
In the Proposal Document  Setup option 
dialogue box, the first box asks you to 
Name the proposal template. This name field is limited to 8 characters. 
 
Next you are asked to provide a Description of this proposal template.  This is a longer 
field allowing for you to be more descriptive.  For example, a description of the template 
that will merge information from the Commercial Property application could be titled 
―Proposal – Commercial Property‖.   Because the proposal area can be used for more 
than just proposals (think Schedules or Summaries of Insurance), the word ―Proposal‖ 
or some other unique indicator in the description allows you to easily locate the 
individual documents you want to include in a particular Proposal Setup. 
 
As with formletters, in some screens proposal documents are sorted by Name and in 
other screens they are sorted by Description, so it‘s a good idea to have the Name and 
Description start with the same characters. 
 
The next section allows you to choose what Association you want to make.  If you want 
this particular proposal document to pull application specific detail, then you would 
select the appropriate ACORD application or custom dec from the drop down list.   
 
When you come back into the setup area in the future to edit a proposal document, you 
will have another button between OK and Cancel, the Edit button.  Selecting Edit will 
open the letter for revisions after it has been created the first time. 
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Proposals Setup 

In order to use any proposal documents you create or edit, they must be in a Proposal 
Setup. Creating a Proposal Setup is a two-step process.  First the individual document 
templates must be created or edited. Second, the individual document templates must 
be selected to pull as part of a proposal setup. 
 
To add a new setup, while 
Proposal is selected under 
Document Type, click on the 
Setups button under Options.  
Click ―New‖.  You are asked if 
you want to add a new proposal 
setup.  Click Yes.   
 
 
 
 
 
 
You are required to select an Activity Category you want associated with the particular 
proposal setup.  You then must provide an up to eight character name for the Proposal 
Setup.   
 
Note:  For the end user, the proposals are sorted 
based on this eight-character code. It is therefore 
a good idea to have the first couple of characters 
of this code be the same as those in the 
description. 
 
In addition, you can force items to the top of this 
list by having the first character be a number. So if 
you have several CL proposals, but one of them is 
the most used, name it  
1CLPROPSTD with a description of 
1 CL Proposal - Standard 
 
 
You are required to select an Attachment Category that will be used when the proposal 
is added at the client level.  You would then select from the list of available documents 
on the left & double click or click ―Add‖ to move them into the ―Documents in Proposal‖ 
area on the right.  You have the ability to move a document ―up‖ or ―down‖ in the order 
you want the individual templates to merge from client level.   Click OK when complete. 
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Launching the TAM/Word Interface   

Whether you are adding a formletter or proposal document, once the setup box has 
been completed as needed, clicking OK opens the TAM/Word Interface to create the 
document.  You are now presented a blank Word document upon which to work.   
 
To see the Basic TAM/Word Interface functions, click on Add-Ins tab, then the Applied 
drop down in the ribbon.  It is suggested that you add the Applied drop down menu 
button to your Quick Access toolbar. 

 
 
 
 
 
 
 
 

 
The options are shown in the dialogue box. 

 
 
 
 
We‘ll discuss each one individually as we review the typical 
steps taken in creating a formletter or proposal document. 
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Building Your Document – Basic Tools 

Dates in Documents 

If you want to insert the current date in your formletter or proposal document, you need 
to insert a variable to show the correct date each time this letter is merged on the client 
level.  Click on the Insert tab on the ribbon, then Date & Time, and choose the format of 
the date that you would like to use in your document.  Be sure to click the box next to 
Update Automatically so that this variable pulls the current date when the formletter is 
merged to the client instead of the date you originally created the template!  Click OK to 
insert the date field into your template. 

TAM Data Fields 

You may incorporate a great deal of data directly from TAM.  Field codes are used to 
update the formletter or proposal template with information from the data that has been 
entered in TAM.  If you change your application, for example, then the next time the 
proposal is run it will contain the new information. This saves time since you do not 
have to go back and look at the policy for updated information.   Keep in mind that 
document variables can be formatted in the same way as any other text. For instance, 
in a merged letter to a client, you can format the expiration date to be bold or a larger 
font from the rest of the text in order to emphasize it. 
 
To insert variables that will pull individual client data when the letter or proposal is 
actually merged on the client level from the Add-Ins tab on the ribbon, click on the 
Applied icon in the Menus Command group, then select Data.  Doing so opens up a 
new dialogue box with a listing of the data categories & data fields available for 
insertion. 
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On the left under Category, there is a list of various areas from where you can pull data.  
For instance, Client Data pulls information from the main client detail screen.  In the 
picture shown above, we have highlighted Client Data.  In the top right box, the 
available variables are listed.  When you have identified the appropriate variable that 
you want to insert into your document, select it (the Add button will become activated), 
click on Add and your variables to be inserted will be listed in the box at the bottom of 
the screen, then click OK.  You can also double click on the item in the top box to add it 
to the bottom box.  You can select multiple variables at one time to add into your 
document by holding down the CTRL or SHIFT keys on your keyboard.  You will need 
to separate them in the document once inserted so they are appropriately positioned. 
 
HINT:  To insert the complete client name & address fields, including the Attn field if 
data exists in that field, scroll down the list of available fields under Client until you get 
to the field called ―Address‖.  This saves you from having to insert & format each of the 
fields separately. 
 
It is especially important to note the various Categories on the left from which you can 
choose to insert variables.  For instance, selecting the CSR from the Client Data level 
(which pulls from the client detail screen) might not be the same as the CSR pulled from 
the Policy Linked Items level (which pulls from the policy billing detail screen).  The 
same is true of Account Producer which pulls from the main client detail screen, versus 
Producer #1 Data which pulls from the billing detail screen.  Be sure that you are 
selecting your variables from the correct category before inserting. 
 
In our example above, note the ―+― sign next to Policy Linked Items and Contact Data.  
To see additional categories of data available from those areas, expand the data tree by 
clicking on the ―+‖ sign.    
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Below is an example of a formletter with some variables inserted. 
 

 

ASK Variable 

What happens when you want to pull in information that cannot be found on the 
application or other areas of TAM?  You can set up your document to ask the end user 
creating the letter or a proposal a question, the answer to which will be used in your 
formletter or proposal.  This is called an ASK Variable and can be found on the Applied 
Menu.  

 
The variable name is used to identify the question and 
its resulting answer.  To avoid possible problems 
later, use only numbers and letters – and no spaces – 
in the variable name although you can use an 
underscore to separate parts of the variable name. 
The variable name itself will never appear in your 
printed document BUT each field does need a unique 
name.  Note:  Make sure the variable name is 
different from any data field names in TAM. 
 
The prompt is the question that will be asked every 
time the document is merged.  Be very specific here, 
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especially if you want your responses to be consistent (Note:  If you want to use the 
ampersand symbol in your Prompt, enter two of them ―&&‖; otherwise, they show up as 
an underscore).  You can also provide an example of how you want the end user to 
answer the question in the Prompt area. 
 
Finally, the default value field, if selected, will automatically place that information in the 
document unless overwritten by the end user.  It is not necessary to enter a default 
value.  Once all fields are completed as needed for your particular purpose, click Insert 
and you will receive a ―preview‖ of how the end user will see the ASK variable.  Click 
OK to insert the ASK variable into the proposal template. 
 
The ASK variable ―code‖ appears as follows in your template (press Alt-F9 if necessary 
to see the code). Here are two examples of ASK variables, one with a default value 
included, the other without: 
 

 
 
The second field on each line - {REF variablename} – is the code that actually inserts 
the end user's response into the document.  By default, TAM assumes you want this at 
the point where you asked for it. However, you can move it or copy & paste it wherever 
you want it to appear in the document, and as many times as you wish. (Just make sure 
you don't move the {REF variablename} to a point before the ASK statement – it won't 
work because the REF hasn't been created yet.) 
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IF Statement (Conditional Statement) 

An ―IF statement‖ is a true or false statement.  It uses an ―operator‖ to compare specific 
information (e.g. a field value in the database, or result of an ASK variable) to a 
particular value entered in the IF statement.  The format of an IF statement is:  
 
{IF "Expression" Operator "Comparison Expression" "TrueText" "FalseText"}  
 
If you want to make a comparison or insert information based on application data found 
in TAM, you can insert an IF Statement from the Applied Menu. 
 

Once you select to insert an IF Statement, 
the Conditional Statement Builder dialogue 
box appears.  Creating an IF Statement is 
like creating an Algebraic equation: if x=y 
then perform z.   
 
For example, if we were creating an 
Endorsement to Insured letter, we could 
create an IF statement based on the Billing 
Mode reflected on the billing detail screen.  
If the policy is direct billed, then tell the 
client the endorsement premium will be 
reflected on their next statement from the 
company; if the policy is not direct billed, 
then tell the client our invoice is enclosed 
for the endorsement premium.  The IF 
statement will look at the Billing Mode field 
on the billing detail screen and make a 

comparison; depending on the value, it will insert the appropriate information into our 
document as a result. 
 
To create the first part of the statement – or expression – click in the Expression field 
and then select Use Field from the bottom of the dialogue box.  A box very similar to the 
Data option box we referenced before appears letting you select the data variable you 
would like to use in your expression.  For our example, expand Policy Linked Items, 
then select Policy Detail.  Scrolling on the right, find the variable you are looking for: Bill 
Mode.  Select the variable by double clicking on it and click OK. 
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Now that we have our expression started, we need to determine what our Operator will 
be.  Let‘s refresh our math terminology:   
<  Less Than 
<= Less Than or Equal To 
<>  Not Equal To 
=  Equal to 
>  Greater Than 
>=  Greater Than or Equal to 
 
Let‘s refer back to our statement:  If the policy is direct billed, then insert the appropriate 
text.  So we need to exactly match the billing mode to the criterion equal to direct bill.  
Click the down arrow in the Operator field and select the = sign. 
 
Note:  When making comparisons using numeric values, the other operators are very 
useful.    
 
Next we need to complete our Comparison Expression.  In this case we are looking for 
direct bill.   It is very important that you know exactly how TAM stores the data and put 
the appropriate response in the Comparison Expression field.  On the billing screen, the 
bill mode displays as ―Agency‖ and ―Direct‖, but what TAM actually stores is ―A‖ and ―D‖.  
The letter D, which is the character in the bill mode field for Direct Bill, will be all that is 
put in the Comparison Expression field.  If you aren‘t sure how TAM stores the data, 
simply put the raw field in the document and run a test on a client to see what prints.  
Also be aware that these values are case sensitive so a lower case ―d‖ is not the same 
as an upper case ―D‖.  When comparing numbers, check the box next to Numeric. 
 
Note:  In order to test for a blank (empty) field, you actually need to insert a single space 
in the Comparison Expression box. 
 
Now we have our expression: 
IF ―{DOCVARIABLE 
CPOL.POLICY.BILL}‖=‖D‖} 
 
Now for the ―THEN‖ part.  We said if the policy 
is direct billed, we wanted to explain how the 
client will receive the billing for the 
endorsement directly from the company.  So in 
the text box If expression evaluates to true, 
insert the following text: 
which will be reflected on your next billing 
statement from <<CPOL.POLICY.BCO>>. 
Note that we clicked on Use Field here to insert 
the Billing Company datafield, so that when we 
print the letter on a client it will contain the 
name of their insurance carrier. 
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But if the statement is not true, then we wanted to explain that our agency‘s invoice is 
enclosed.  So, in the text box If expression evaluates to false, insert the following text: 
and our invoice for this amount is enclosed.  Please be aware that your payment is due 
within 15 days from receipt of this invoice. 
 
Once you have completed all fields in the Conditional Statement Builder dialogue box, 
you can click on Insert and the IF Statement will be inserted into the formletter or 
proposal template. 
 
The IF statement looks like this when inserted into the template: 
 

 
 
The Conditional Statement Builder is a powerful tool.  Later on, you will also learn how 
to use answers to ASK variables as the basis of IF Statements, how to ―nest‖ IF 
statements (insert IF statements within IF statements), and more. 
 
When using the Applied menu to insert an IF statement into your document, you are 
limited in what you can insert in the true and false sections of the statement. However, 
you can edit the statement in your document after it's been created and there are 
virtually no limits on what you can put in each section.   
 
To have the ability to format true and false responses in greater detail: 

 Place your cursor in the document where the results of the IF statement will 
reside.   

 From the Add-Ins tab on the ribbon, click on the Applied icon in the Menus 
Command group, then select IF Statement. 

 Complete the first 3 boxes (Expression, Operator, Comparison Expression) with 
the info you want in them.  

 In "true" and "false" sections, insert placeholders for now (you could use "aaa" 
and "bbb", "true" and "false", etc.).  

 Click on Insert to put the statement in your document.  

 Now, after pressing Alt-F9, if necessary, to reveal your field codes, you can edit 
the expression replacing the placeholders with whatever you want. There is no 
limit on the amount of text you can place in there, including paragraph marks, 
page breaks, tabs, formatting, even inserting existing files, objects or pictures! 
Just be sure that when you are replacing the placeholders, you leave the double 
quote marks " " in place. 
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Replicate Command 

The purpose of the Replicate command is to allow you to generate a list of scheduled 
information from an application in TAM.  In order to use the Replicate command in a 
formletter or proposal template, that template MUST be associated with a form (ACORD 
application or Custom Dec) that has a schedule.  The Replicate command tells the 
system to refer back to the application to repeat the insertion of the variables selected 
(for example, YEAR, MAKE, MODEL and VIN), as many times as it finds information in 
those fields.  So if you have three vehicles on the app, all three vehicles will pull into 
your letter or proposal.   
 
Pull the TAM data fields into the template first, and format them as needed. Add a line 
with the column headers, and test – you‘ll only pull the first vehicle in, but this will show 
you whether you have the correct data fields, formatting and spacing.  Then insert the 
Replicate command, entering a return at the end of the Begin Replicate command 
followed by cutting and pasting the line that contains the data fields between the Begin 
and End commands. 
 
Here is a very simple example of a Replicate. 
 

 
 
It is important to remember as you use the Replicate command that any typing or 
formatting that appears between the Begin and End commands will be replicated.  That 
means any returns, tabs, spaces, tables, etc. will be repeated. That‘s why the column 
headers are before the replicate starts – you only want the headers once. 
 
Later on we‘ll see how to create your data in a table, giving you much more control over 
the layout. 
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Part 2 – Intermediate Tools 

Using Existing Templates 

Once you have created a formletter or proposal document that has the look and style 
you want, it is a time saver to use that as the basis for your other documents instead of 
starting with a blank document each time. Here is how you can do that. 
 

 Open up Windows Explorer and navigate to the DOC folder on your TAM drive 
o If you are copying a formletter, go to the \CFORMLET folder 
o If you are copying a proposal, go to the \PROPDOC folder 

 Find and highlight the file you wish to copy 

 Right-click and Copy (or Ctrl-C) 

 Right-click in a blank area of the window and Paste. 

 Rename the file from ―Copy of …‖ to the 8 character (max) you want for your new 
template. Make sure you keep the .RTF extension. 

 In Document Setup, create a new document with the file name you just created. 
When you click OK the copy you just created will open and you can edit it as you 
wish. 
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Advanced Utilization of ASK Variables & IF Statements 

ASK/IF Combination 
In order to use a combination of the ASK variable and IF statement, create the ASK 
variable first.  For example, in some cases you need a deposit in order to bind 
coverage.  So we ASK the question whether a deposit is needed,  then we create an IF 
statement that "reads" the answer to the question and prints different text in the letter 
depending on the answer. 
 
To create the ASK/IF combination: 

 Create the ASK statement. It will look like this: {ASK deposit "Will a deposit be 
needed to bind coverage? Answer 1 for Yes or 2 for No"}{REF deposit} 

 Place the cursor where you want the results of the IF statement to appear in the 
template. 

 Open the IF Statement builder box. 

 Put a placeholder in the ―expression‖ field in the IF statement. 

 Complete the rest of the IF statement fields as needed. 

 Click INSERT. 

 Place the cursor between the ASK and the REF parts of the ASK variable. 

 Hold down the SHIFT key and using the right arrow key on the keyboard, select 
the entire REF portion of the ASK variable (including the parentheses marks). 

 Cut (CTRL+X) the selected REF field and then place your cursor at the beginning 
of the place card you used in the ―Expression‖ portion of the IF statement. 

 Hold down the SHIFT key and using the right arrow key on the keyboard, select 
the entire place card. 

 Paste (CTRL+V) the REF into the expression portion. 
 
The IF statement would look like this: 
{IF {REF deposit} = "1" "In order to bind coverage we will need a deposit in the amount 
shown on the premium summary page." "No payment is needed to bind coverage; you 
will be billed later."} 
 
The actual answer to the question asked is never printed in the document; it is used to 
decide what other text is inserted in the document. 

Nested IF Statements 
Nesting is putting IF statements inside other IF statements.  You would want to use this 
feature if you have more than two values you are comparing.   
 
For instance: 
You only want to offer premium financing if the policy is agency bill AND the premium is 
at least $10,000.  The completed IF statement looks like this: 
 
{IF <BILL.TYPE> = "A" "{IF <PREMIUM> >= 10000 "Premium financing is available. 
Please call me if you are interested in details." ""}" ""} 
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Let's analyze that statement: 
If the bill type is agency, then the ―true‖ section will apply. The ―true‖ section for the first 
IF statement is actually the second IF statement.  So now the code will look at the 
premium amount; if it's greater than or equal to $10,000, the ―true‖ section for the 
second, or nested, IF statement will kick in, printing the sentence about premium 
financing. However, if the premium is less than $10,000, that sentence will be skipped, 
and since the ―false‖ section is empty, nothing will print. Similarly, if the bill type is not 
agency, the entire second IF statement will be skipped and again nothing will print 
because that ―false‖ section is also empty.   
 
To create this nested IF statement: 

 Create the first IF statement, testing for <BILL.TYPE> equal to ―A‖.  Put a place 
holder such as ―abc‖ or ―true‖ in the ―true‖ section and leave the ―false‖ section 
blank. 

 Click Insert. 

 Click ALT+F9 to reveal the entire coding of the IF statement, if necessary. 

 Place your cursor at the beginning of the ―true‖ section and holding down your 
shift key, use the right arrow key on the keyboard to select the placeholder text. 
Make sure you do not select the double quote marks at either end of the 
placeholder. 

 From the Add-Ins tab on the ribbon, click on the Applied icon in the Menus 
Command group, then select IF Statement. 

 Create the second ―nested‖ IF statement, testing for <PREMIUM> equal to or 
greater than ―10000‖. In the ―true‖ section, type the ―Premium financing…‖ 
wording; leave the ―false‖ section blank. 

 Click Insert. 
 
You can nest several IF statements inside of each other although Applied recommends 
nesting IF statements no more than 15 deep within a single IF statement.  
 
Some other suggested uses for Nested IF Statements: 

 Pull in signature graphics based on Producer, CSR or Operator ID.  

 Pull in agency logos based on Agency or Branch code.   

 Pull Producer direct phone numbers or email addresses based on Producer code 
into your Agency Service team template.  
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Using Tables with Replicate Command 

Use tables to organize information and even create interesting page layouts with side-
by-side columns of text and graphics. You can create a new blank table with the Table 
button under the Insert tab on the Ribbon and fill in the empty cells, or you can convert 
existing paragraphs of text (separated by a character such as a tab) to a table. One of 
the best features of a table is the ability to format by column, row or cell.  Tables are a 
great replacement for tabs to align schedules in TAM.  
 
Tip:  Never create a table on the first line of a document. Always put at least one 
paragraph return before the table; otherwise, your document will not work when you use 
it at the client/prospect level. 
 
To create a table using the Replicate Command: 

 If you are at the top of your document, Return at least once. 

 Create a table with 2 rows and as many columns as you need. 

 Click once anywhere in the table, right-click and select Table Properties, Options 
and uncheck the box ―Automatically resize to fit contents‖. 

 In the first row, type the headers for the schedule. Format as desired. 

 In the second row, insert your data fields (Applied, Data Fields) with whatever 
formatting, IF statements, etc. needed. 

 Adjust the column widths for the headers and data, keeping in mind that your 
actual data may be shorter than the field name.  For example, the year of a 
vehicle is four digits long, whereas the field name is AP.EF.MODEL_YEAR, 
which is 33 characters including all of the formatting. 

 Save the document and test it on a client. Since you haven‘t put the Replicate 
commands in yet, you will only get the first item in the schedule from the app, but 
you will be able to see whether you have the formatting and column widths 
correct. If not go back to the document, adjust as necessary, and test again. It is 
a good idea to test on more than one client because different data may have 
different lengths. 

 Once you are happy with the formatting, go back into the master document and 
place the cursor directly below the table. 

 On the Applied Menu select Replicate Command. 

 Place cursor at the end of the Begin Replicate command and press the Enter key 
to create a line between the Begin and End command. 

 Take the mouse out to the left of the 2nd row containing the data fields and left-
click to select that row. 

 Right-click and select CUT (or CTRL+X). 

 Place cursor on the line between the two Begin and End commands and right-
click and choose PASTE (or CTRL-V). 

 DO NOT cut and paste either of the replicate commands as this will disable their 
functionality. 
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The end result will look similar to this: 

 
Save the document and test it. Access and edit the template to adjust as necessary. 
 
Note:  If you need to adjust column widths after you do a test merge, it is recommended 
that you delete the Replicate commands so that the table heading & data row are 
merged into one table.  Once you have made the necessary adjustments, repeat the 
steps above to re-insert the Replicate commands. 

Formatting Fields 

There are many fields available in Word in addition to the ASK and IF fields that are on 
the TAM/Word Interface menu. To see the selection that‘s available, from the Insert tab, 
click on the Quick Parts icon, and select Field.  
 
A Word field begins and ends with curly brackets, { }.  Typing in the curly brackets from 
your keyboard will not create a Word field.   You need to insert them from the Insert Tab 
on the ribbon as described above.  Once you are familiar with a particular field and how 
to format it, you can save yourself time and mouse clicks by inserting a blank field using 
CRTL+F9, then typing the field command and any options between the curly brackets. 
  
Two fields that are very useful in proposal templates are the Formula field, { = }, for 
formatting numbers; and the Quote field, { QUOTE }, for formatting text. You can 
incorporate various formatting instructions within these field commands so that 
numbers, dates and text appear the way you wish, regardless of how they are entered 
in the TAM or the responses to ASK statements. 
 
As you are working with Fields and formatting them, if either the field disappears from 
the screen or you can‘t see all of the formatting that you know is there, press ALT+F9 to 
reveal the field coding & formatting. 
 
For more information about fields and the options that are available, search Word Help 
for ―fields‖, ―field codes‖ or ―field switches‖. 



Creating Formletters and Proposals Using the TAM/Word Interface 

September, 2011 26  
 

Numbers 
Coverage limits in most ACORD applications in TAM are required to be entered with no 
―$‖ sign or comma separators. To display them in your proposal or letter with those 
punctuations, enter them in a Formula { = } field, like this: 

 
 
This format will fail if the data field is empty and you will get an ―Error!‖ message in the 
merged proposal.  To avoid this, we can use an IF statement to test the field first and 
force a zero into the formatting expression if the field is blank.  There is also a more 
complicated version of the number formatting which allows you to have a text 
expression print instead of $0 if the field is blank or zero. For instance, for a deductible 
you might want to print ―No Deductible‖ or ―None‖; if a limit field is blank, you might want 
it to print out as ―No Coverage‖.   
 
To include this text as part of the number formatting, enclose the ENTIRE formatting 
string, beginning before the ―$‖ sign in double quotes, separate the number format from 
the text you want to use by two ―;‖ characters AND enclose the text in single quotes.  
This more complex format, with the IF statement test, looks like this: 

 

Upper/lower case text 

Generally, you want text formatted in upper and lower case (not ALL CAPS), but data 
may be entered in applications in any number of ways.  You can use the {QUOTE} field 
with the appropriate switches to change the appearance of the field value in the merged 
document: 
 
{QUOTE "<VEHMAKE>" \* Caps} Each Word Starts With an Uppercase Letter 
{QUOTE "<VEHMAKE>" \* Upper} ALL UPPERCASE 
{QUOTE "<VEHMAKE>" \* Lower} all lowercase 

Fields that might contain numbers or text 

There are some fields in Applied that might contain numbers or text. For instance, a limit 
field might have a number in it or the word "Included".  The formatting techniques 
described above only work if the field contains data of the expected type. However, with 
yet another IF statement we can get around this. We are taking advantage of the fact 
that Word considers letters to have a higher "value" than numbers. So, we test the first 
character of the field to see if its value is less than the lower case letter "a".  If it is, we 
apply number formatting; if not, we apply text formatting. Here is an example of this field 
formatting: 
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Note:  This use of field switches will not work if the field contains mixed numbers and 
text ("$5,000 Included").  Unfortunately, there is no way to test for and correctly format 
this kind of entry. 

Dates 

By default, TAM dates will print as xx/xx/xx – for instance, 01/30/09.  You may want the 
date written out – as January 30, 2009. For this, use the { QUOTE } field: 

 
 
There are many more ways of formatting than the examples shown here. For additional 
information, go to Help in Word and search for Field Codes. 

Drawing Lines 

There are several ways to draw lines in documents, and some work better than others, 
depending on the circumstances.  One way would be to type an underscore character 
as many times as needed to create the desired line length.  To get a line completely 
across the page, type 3 underscore characters followed by Enter key. To get a double 
line, repeatedly use the = character instead of the underscore character. The problem 
with this method is when it is used as a line on a form (e.g. a company app) where the 
end user is entering information, the line will be pushed to the right instead of the text 
appearing on the line.  This is because the underscore character is a typed character.   
 
Another method for creating a line is using Underline formatting, which can be useful 
when inserting datafields.  If you set up the datafield in your formletter or proposal 
template as underlined, then the data will be underlined in the merged document at the 
client level. The underlining will be as long, or as short, as the data itself. 
 
Yet another method is to draw lines in your formletter or proposal template.  These lines 
are independent of the text and will remain in the same place, and the same length, no 
matter what data is inserted.  

Pictures 

Inserting pictures into your document is a simple task.   Before inserting a picture, go 
into the Advanced Section of Word Options in the Office button and make sure the box 
―Show picture placeholders‖ is unchecked. Otherwise, Word will show an empty box in 
your document instead of the picture itself. 
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Inserting a picture in an IF statement 

You can insert a picture into an IF statement.  To do this, place the cursor in the desired 
location within the IF statement.   For instance, perhaps you have 2 agency logos and 
you want to use logo #1 for Agency #1 and logo #2 for Agency #2. Create an IF 
statement that tests if the Agency datafield is equal to 1; between the double quotes of 
the "if true" section, insert logo#1, and between the double quotes of the "if false" 
section insert logo#2.  
 

 
 
Format the pictures to be the size and location you want. In the formletter or proposal 
template, the pictures may not appear in the desired location.  Merging the template at 
the client level will reveal the true location of the picture.  You may need to reposition 
your picture in the template based on how it appears when it is merged at the client 
level.   

Math Functions in Tables 

Although not as powerful or as varied as Excel, there are some basic math functions 
available within tables in Word.   
 
Tables have cell references just like Excel EXCEPT you do not see the Column and 
Row labels.  In the example shown below, the cell reference is displayed in each cell: 
 

A1 B1 C1 D1 

A2 B2 C2 D2 

A3 B3 C3 D3 

 

In the IF statement, put your Agency 

Two logo in the “If False” section 

In the IF statement, put your Agency 

One logo in the “If True” section 
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Place your cursor in the cell where you want the formula results to be displayed.  The 
table tabs on the ribbon will activate.  Click on the Layout tab, then click on the formula 
button. 
 

 
 
If there are numbers displayed in the cells above or to the left of the selected cell, an 
automated formula (=Sum(Above)) or (=Sum(Left)) will be shown in the formula field. 
 
If neither of these is the desired formula, delete the automated formula leaving just the 
equal (=) sign in the brackets. Or of course you can enter the field manually as 
described earlier, with Ctrl-F9 and typing inside the brackets. Then enter the formula 
you need based on the available functions.  Examples of the available functions are 
shown below. 
 
Add – "+" 
Add a number to a cell =(A1)+3 
Add two adjacent cells =SUM (A1:A2) or =(A1+A2) 
Add two non-adjacent cells =(A1+A3) or =(A1)+(A3) 
Add a range of cells =SUM(B1:B3) 
Add an entire column =SUM(D:D) 
  
Subtract – "-" 
Subtract a number from a cell =(A1)-1 
Subtract two cells =(A3-B2) 
 
Multiply – "*" 
Multiply a cell by a number =(A1)*3 
Multiply two adjacent cells =PRODUCT(A1:A2) 
Multiply two non-adjacent cells =(B1*B3) or =PRODUCT(B1)*(B3) 
 
Divide – "/" 
Divide a cell by a number =(C2)/3 
Divide two cells =(C2)/(A1) 
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If you are using the Formula button the Layout tab, select 
the function from the Paste Function box.  For instance, 
to add numbers, choose SUM from the Paste Function 
drop down box. Or you can manually type these functions 
into the formula field. 
 
To reference cells in formulas, use a comma to separate 
references to individual cells (i.e., (=SUM(A1,B3) and a 
colon to separate the first and last cells in a designated 
range (i.e., (=SUM(A1:D1).  You can reference an entire 
row or column in a calculation in the following ways: 
 

 Use a range that includes only the letter or number 
that represents it — for example, 1:1 to reference 
the first row in the table. This designation allows the calculation to automatically 
include all the cells in the row if you decide to add other cells later.  
 

 Use a range that includes the specific cells — for example, a1:a3 to reference a 
column with three rows. This designation allows the calculation to include only 
those particular cells. If you add other cells later and you want the calculation to 
include them, you need to edit the calculation.  

 
You can format the results of your formula by selecting the format from the available 
options in the Number format box. For example, to display the numbers as a decimal 
percentage, click 0.00%.  
 
Notes:  
Word inserts the result of the calculation as a field in the cell you selected and does not 
automatically update the formula results if there are changes to the referenced cells. 
You can update the calculation by clicking once on the field (or selecting the entire 
table) and then pressing F9. Also, once you build the proposal at the client level, all the 
formulas are replaced by the actual results; if you change the numbers in the cells the 
total will need to be updated manually. 
 
If you see codes between braces instead of the actual sum (for example, {=SUM(LEFT)} 
not the number result you wanted), press SHIFT+F9 or ALT+F9 to switch to the number 
result. 
 
See the Appendix for a couple of samples showing how you can use formulas 
containing math functions. 
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Styles 

Styles define the appearance of various text elements of a document, such as 
headings, captions, and body text.  When a style is applied to any portion of a 
document, multiple character or paragraph format options will be applied in a single 
operation.  When a change to the formatting of all of the text of a particular element 
needs to be made, simply change the style that's applied to that element.  Styles make 
formatting your document easier. Additionally, they serve as the source information for 
outlines and tables of contents. 
 
The template asword.dot includes styles designed by Applied for formletter and 
proposal templates.  A key element in setting your agency apart from your competition 
is the creation of styles UNIQUE to your agency. 
 
Styles can also cause problems in formletters and proposals, if you use the default style 
names that are built in to Word. This is because those style names exist on every 
workstation in your office – but they do not necessarily all have exactly the same 
features. For instance the Normal style on one workstation might be Times New 
Roman 12, and on another workstation Arial 10. When you run a formletter or proposal 
on a workstation, it overrides the style definitions in the document with those on the 
workstation, if it finds styles with the same name. So we strongly recommend that you 
create unique style names for your agency‘s documents, and use those exclusively.  
 
One of the first steps in creating those unique styles is determining the formatting to 
include in the various styles you want for your agency‘s proposal templates. You will 
need several styles, for page headers, subsection headers, paragraph (or body) text, 
and so on. You may want to define a style for table column headings for instance. 
 
When you are determining formatting, here are some of the elements you will need to 
consider when creating each unique style for your agency. 

 font type  

 font size  

 bold 

 italicize 

 underline   

 justification:  left, right, center or full 

 paragraph spacing 

 borders and shading 

 color 
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Creating Your Agency’s Unique Styles 

The steps below will help you to create your own unique styles. 

 On the Home tab, select the dialogue box icon in the bottom left corner of the 
Styles group.  
 

 
 
 

 Click on the NEW Style button at the bottom of the Styles dialogue box.   You 
can use text that has already been formatted as the basis for a style.  To do this, 
highlight the desired text before creating a new style.  
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Address the following areas in the Create New Style from Formatting box:  
o Name – Type in a name 

for the style you are 
about to create – this 
name should be unique 
(e.g., initials of your 
agency & then type of 
style –  
BHB PropNormal). 

o Style Type – Pick the 
appropriate type from 
the dropdown list – 
Paragraph is the most 
commonly used. 

o Style Based On – It is 
recommended that you 
select "No Style" from 
the top of the list. If you 
base your agency style 
on an existing style that 
may have different 
properties on the 
various workstations in your office, you run the risk of having 
inconsistencies in the proposals in your office, depending on what 
workstation they are created on.  

o Style For Following Paragraph – All existing styles are listed – you can 
select the style you want for the text that will follow in the next paragraph. 
(it can be the same style as the one you are creating.) 

o Formatting – In this area of the dialogue box, you can select text 
formatting options such as font and size.  Note:  Formatting options are 
available under the Format button in the lower left hand corner as well.  

o Click the ―Add to Quick Style List‖ if you want to see this particular style on 
the Home tab in the Styles group. 

o By checking the Automatically Update check box, Word will automatically 
redefine the style you selected whenever you apply manual formatting to 
any paragraph with this style.   This option is OFF by default and is 
recommended for experienced style users only.  This option is only 
available for paragraph styles, and is not recommended for the Normal 
style. 

o Verify the ―New Documents Based on this Template‖ radio button is 
selected. 

o Once this dialogue box has been completed to your satisfaction, click OK. 

 This style has now been added to the normal.dotm template. 

 Repeat the above process for each style that will become a part of your 
customized proposal templates. 

 Close Word, there is no need to save changes. 
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Adding Agency Styles to Proposal Templates 

To copy the unique styles you created for your agency into proposal templates, you will 
need to use the Style Organizer.  The organizer feature is not available from any of the 
ribbon tabs.  When working with customizing proposal templates, you should add this 
command to the Quick Access Toolbar.   
 
Here are the steps for adding the Style Organizer command to the Quick Access 
toolbar. 

 Right-click anywhere on the Quick Access Toolbar. 

 Left click on Customize Quick Access Toolbar. 

 In the ―Choose Commands From:‖ field, click the drop down arrow and select ―All 
Commands‖. 

 In the available fields tab, scroll down and locate Organizer and click the ―Add‖ 
button to move that command into the list of selected commands to be displayed 
on the Quick Access Toolbar. 

 Click OK and exit Word. 
 
To add the Styles to your proposal documents: 

 Opent the desired proposal template to which you need to add your agency‘s 
styles. 

 Click Revise. 

 Click Edit. 

 Click the ―Organizer‖ icon  
on the Quick Access Toolbar. 

 Hold down the CTRL key and 
select the styles from the ―In 
Normal‖ list on the right and 
then click on the Copy button 
to move these styles to the 
active proposal template. 

 Click Close. 
 
Your agency‘s defined styles now reside in the individual proposal template.  If you are 
utilizing a copy of an existing TAM template, select text and apply styles as needed.  If 
you are creating a NEW proposal template, enter text and apply styles as needed. 



Creating Formletters and Proposals Using the TAM/Word Interface 

September, 2011 35  
 

Appendix – Math Samples 

Here is a sample of the coding for creating a total of the values in an equipment 
schedule. 

 The total is outside the replicate commands. You only want one total! 

 The formula uses the SUM function referencing the fourth column (column d) in 
the table. By using this method instead of SUM(ABOVE), the total will be correct 
even if there are blank limit entries. SUM(ABOVE) stops calculating if it 
encounters a blank cell. 

 Apply the same formatting to the total formula as you apply to the individual 
items. 

 
 
And here‘s the result on the client‘s proposal: 

 



Creating Formletters and Proposals Using the TAM/Word Interface 

September, 2011 36  
 

Here we use the sum and multiply functions to multiply the results of ASK variables by 
various factors to obtain the applicable tax and fees, then add those items together to 
get the total amount due. 
 
Formulas Look Like This: 

 
End Result is this: 

 


